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Minimum System Requirements

Microsoft Windows 2000 (with Service Pack 4), Windows XP

Available disk drive that will be dedicated to EzBackup
< Backup drive can be an internal (IDE, SATA, SCSI) or external (USB, FireWire, eSATA)

drive
< Backup drive must at least as large as the drive you want to backup (usually your C:\ drive)

256 MB of free hard drive space

256 MB of RAM

4X CD-ROM Drive or better
< If EzBackup was installed from a web download, a CD-R/W (CD writer) drive is required,

which will be used to create the bootable Recovery CD.

800 x 600 minimum screen resolution
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Introduction

EzBackup™ is a complete drive to drive backup and restore solution. It is designed to protect
users against data loss, whether that loss is due to a single inadvertently deleted file or the
failure of an entire hard drive.

EzBackup will create a mirror image (an exact duplicate) of your computer’s internal hard drive,
including the operating system, applications, settings and data files, on a second drive.  The
destination drive can be either an internal or an external drive.  

After the initial image backup has been created, EzBackup will keep it up-to-date with file
backups. These are backups of files and folders that can be run manually or set to run
automatically at a scheduled time. In the DEFAULT BACKUP MODE, each new backup
overwrites the files in the previous one. In the INCREMENTAL BACKUP MODE, each backup is
maintained separately as a dated restore point.

EzBackup’s Partition Expander tool is designed to allow users to migrate easily to a larger hard
drive.

This product manual uses the following conventions: 

ALL CAPS for application-specific terms such as IMAGE BACKUP
BOLD CAPS for required actions such as “click on NEXT”

(Most actions in the software require that you click on the NEXT button to continue.)

Because EzBackup overwrites all data on the BACKUP DRIVE each
time you perform an IMAGE BACKUP, your BACKUP DRIVE should be
dedicated to EzBackup and should not be used to store anything
other than your EzBackup image and file backups.
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EzBackup Quick Start Guide

This Quick Start Guide is designed to allow Windows users to get up and running quickly.
However, there are many features of EzBackup™ that are not explained in the Quick Start
Guide. For additional information and more complete explanations, please refer to the complete
user manual. 

The Quick Start Guide and product manual use the following conventions: ALL CAPS for
application specific terms, BOLD for required actions.

Understanding What EzBackup Does

EzBackup allows you to create an exact copy (IMAGE BACKUP) of your computer’s hard drive
on your BACKUP DRIVE and to update the backup periodically with any new or changed files.  In
the DEFAULT BACKUP MODE, each new backup overwrites the previous one. In the
INCREMENTAL BACKUP MODE, each backup is maintained separately as a dated restore
point.

Installing EzBackup

The EzBackup software will guide you through the set up process which includes making an
initial IMAGE BACKUP.  Once your IMAGE BACKUP has been completed, you can simply allow
the program’s default settings to run and a FACTORY DEFAULT scheduled file backup will take
place at 4:00 P.M. every day.  Alternatively, you can easily change the DEFAULT BACKUP
SCHEDULE or add more schedules so that backups take place as often and at whatever times
you wish. 

During first-time setup, EzBackup will set up the FACTORY DEFAULT BACKUP SCHEDULE so
that all new or modified files are backed up daily at 4:00 P.M.  This FACTORY DEFAULT
BACKUP SCHEDULE is established for your convenience only and can be easily changed or
eliminated if it does not fit your needs.

1. The EzBackup software must be installed on your hard drive.  Close any open
applications and insert the EzBackup Installation & Recovery CD into your CD-ROM
drive.  When the splash screen appears, click on INSTALL NOW.  Ignore any
warnings you may receive from your anti-virus software.

If the splash screen does not appear automatically, open My Computer or
right-click on the Start button and select Explore to navigate to your CD-
ROM  drive. Double-click on the CD-ROM drive icon to launch the
EzBackup installer.

Your BACKUP DRIVE must be as large or larger than your SOURCE DRIVE.
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Alternatively, you can right-click on the CD-ROM drive icon and select
Explore. Locate and open the Windows folder on the CD-ROM drive, then
find and open the EzBackup folder. Double-click on the setup.exe file  to
start the installation. 

If you are installing EzBackup from a web download, double click on the downloaded
file to unzip it.  The installation will begin automatically.  If the installation does not
begin automatically, navigate to the folder in which you have unzipped or expanded
the EzBackup download file, then find and open the EzBackup folder.  Double-click

on the EzBackup setup.exe file to begin the installation. 

2. When installation has completed successfully, the EzBackup application will launch
automatically. A message will appear offering the choice to ACTIVATE, EXIT or
CONTINUE the EzBackup application. Click CONTINUE to continue loading
EzBackup.

3. A prompt will appear asking you to set up your SOURCE and BACKUP DRIVES. 
Click YES to continue.

4. EzBackup will now search your computer for available drives.  Two drop-down lists,
one labeled SOURCE DRIVE and the other DESTINATION DRIVE, will appear on
screen. Select your SOURCE and DESTINATION DRIVES from the lists and click
NEXT.  

If either drive is not listed, check that the drive is properly connected and turned on. 
If you have neglected to connect or power on an external drive, do so now and click
REFRESH to update the drive lists.  Then select your drives and click NEXT.

If for some reason you need to return to the drive selection screen, you can select
SET UP DRIVES from the File menu.

5. Once you have selected your SOURCE and DESTINATION DRIVES, the Set Up
Backup Options screen will appear.  

If you wish to use the DEFAULT BACKUP MODE (overwrite the previous backup of
your files with the most recent backup), click on the radio button for this option and
click NEXT.  If you wish to use EzBackup’s INCREMENTAL BACKUP MODE option
(maintain each backup of your files as a dated restore point), select this option and
click NEXT.
 

6. EzBackup will now ask if you wish to begin the image backup.  Click YES.

7. EzBackup will restart your computer and begin to create an image backup (an exact
duplicate) of your SOURCE DRIVE to the BACKUP DRIVE.  A progress window will
remain on-screen during copying.  At the end of the copy process, the program will

You cannot choose your system boot drive (normally C:\) as the DESTINATION
DRIVE for your backup.  (This is to prevent you from overwriting your boot drive.)
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tell you that the IMAGE BACKUP was successfully completed and you will be asked
to PRESS ANY KEY TO CONTINUE.  The computer will then restart. 

Your BACKUP DRIVE now contains an exact copy of your computer’s internal drive. 
(For information on backing up or restoring files and folders, please refer to the full
manual.)  

8. When you restart your computer, the EzBackup application will launch automatically
and again a message will appear offering the choice to ACTIVATE, EXIT or
CONTINUE the EzBackup application.  If you click CONTINUE, EzBackup will load
in the background and begin running in trial mode.  A blue EzBackup icon will
appear in the system tray. This activation message will continue to appear on
system startup for the duration of the 30-day trial period or until you activate your
EzBackup software.

Click on ACTIVATE if you already have a license code and wish to register the
software or if you wish to purchase a license code now. The license code can usually
be found on the reverse side of the disk jacket.  Click on CONTINUE if you wish to
continue using the trial version of the software. Or click on EXIT to shut down the
program.

Users who purchase a license online will receive a license code by e-mail, sent to
the e-mail address they registered with.

9. Store the EzBackup Installation & Recovery CD in a safe and handy place. You can
restore backed up files using the EzBackup application that you have just installed. 

However, in the event that you must restore your entire drive to its original (and, if
applicable, bootable state), a full image restore will be necessary which requires
use of the Recovery CD.

You can activate your copy of the EzBackup software at any time by selecting
ACTIVATE from the Help menu. It is recommended that you activate your EzBackup
software as soon as possible.  The trial version of the software allows you to restore
files, but only licensed users will be able to perform an IMAGE RESTORE.

Users who have installed the trial version of EzBackup from a web download will be
able to create a Recovery CD using the CREATE RECOVERY CD option from within
EzBackup once they have purchased a license and activated the software.
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Chapter 1:  Installing EzBackup

Close any open applications.  Insert the EzBackup Installation & Recovery CD into your CD-
ROM drive.  When the splash screen appears, click on INSTALL NOW. 

If the splash screen does not appear automatically, open My Computer or right click on the Start
button and select Explore to navigate to your CD-ROM drive. Double-click on the CD-ROM drive
icon to launch the splash screen. Alternatively,  you can right click on the CD-ROM drive icon
and select Explore. Locate and open the Windows folder on the CD-ROM drive, then find and
open the EzBackup folder. Double-click on the setup.exe file.

If you are installing EzBackup from a web download, double-click on the downloaded file to unzip
it.  The installation will begin automatically.  If the installation does not begin automatically,
navigate to the folder in which you have unzipped or expanded the EzBackup download file, then
find and open the EzBackup folder.  Double-click on the EzBackup setup.exe file to begin
installation.
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If a message appears during installation indicating that you need to install the Microsoft .NET
Framework, click YES.  The .NET Framework provides Windows operating system support for
the EzBackup application and you will need to install it if it is not already installed on your
system.  Installing .NET Framework will in no way impact your system. When installation of the
.NET Framework has completed successfully, installation of EzBackup will continue.
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Completing the Installation Process

 
When the installation process has been completed, click FINISH.  The EzBackup application will
launch automatically.  Remove the EzBackup Installation & Recovery CD from the CD-ROM
drive and replace it in its jacket.

Store the EzBackup Installation & Recovery CD in a safe and handy place. You can restore

backed up files using the EzBackup application that you have just installed. However, in the
event that you must restore your entire drive to its original (and, if applicable, bootable state),
an IMAGE RESTORE will be necessary which requires use of the Recovery CD.

Users who have installed the EzBackup software from a web download will be able to create a
Recovery CD from within EzBackup once they have purchased and activated the software.

Activating Your Copy of EzBackup

When EzBackup launches, you will be given the opportunity to activate your copy.  It is
recommended that you activate your copy at the first opportunity.  The trial version of the

software will allow you to restore files.  However, only licensed users will be able to perform an
IMAGE RESTORE. 

Click on ACTIVATE if you already have a license code and wish to register the software or if you
wish to purchase a license code now. Click on CONTINUE if you wish to continue using the trial
version of the software. Or click on EXIT to shut down the program.

Users who purchase a license online will receive a license code by e-mail, sent to the e-mail
address they registered with. 

You can activate your EzBackup software at any time by selecting ACTIVATE EZBACKUP...
from the Help menu.



            8          

Chapter 2:  Setting Up EzBackup

Before EzBackup can begin backing up your data, you need to provide some basic setup
information. After installing EzBackup for the first time, a pop-up will appear requesting that you
set up your drives. Click on YES to set up your drives.

Choosing Your Drives

EzBackup will require you to verify that the drives it has automatically selected as your SOURCE
and BACKUP DRIVES are, in fact, the correct drives.  Two drop-down lists, one labeled Source
Drive and the other Destination Drive, will appear on-screen. 

Select your SOURCE (usually your internal C:\ drive) and your Destination (BACKUP) DRIVE
from the drop-down lists and click NEXT.  

If a drive that you want to select is not displayed as an option in the appropriate drop-down list,
check that the drive is properly connected and turned on.  Also, check in My Computer to see if
Windows has recognized the drive and lists it among your other drives. If you have not
connected or turned on an external drive, do so now and click REFRESH to update the drive
lists. (You may need to give Windows a moment to recognize a newly connected drive before
the drive information appears). Then select your drives and click NEXT to continue.
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Selecting Backup Options

After you have selected your drives, the Set Up Backup Options screen will appear. You may
choose to use either the DEFAULT or INCREMENTAL BACKUP MODE for your backups. 
 

Default Backup Mode

In DEFAULT BACKUP MODE, when EzBackup backs up  files to the BACKUP DRIVE, new
backups will overwrite the existing files on the BACKUP DRIVE. If you want to use EzBackup in
its default mode, select the DEFAULT MODE option and click NEXT.  

Incremental Backup Mode

If you want EzBackup to maintain each backup as a separate restore point, select the
INCREMENTAL MODE option and click NEXT.

The number of backup and restore points you may maintain will depend on the size of your files,
the frequency of your backups and the capacity of your BACKUP DRIVE.

You cannot designate your current system drive (normally C:\)  as the BACKUP (Destination)
DRIVE.  

The Choose Source and Destination Drives screen is not designed to allow you to restore your
entire SOURCE DRIVE from your BACKUP DRIVE or to restore your BACKUP to a replacement
drive.  See Chapter 7: Restoring an Image Backup for instructions on how to accomplish these
tasks.



            10          

Because incremental backups are linked to the last IMAGE BACKUP, whenever you re-image
your drive (make a new IMAGE BACKUP), both the previous IMAGE BACKUP and all previous
INCREMENTAL BACKUPS are overwritten.  Future INCREMENTAL BACKUPS will be linked to
your most recent IMAGE BACKUP.

After selecting your backup options, click NEXT, and you will be prompted to begin the initial
IMAGE BACKUP.

Initial Image Backup

After you have selected your backup options, you are ready to perform your initial image backup.
Go to Chapter 3: Image Backup for the next step.

Changing Your EzBackup Setup

To view your selected drives at any time, select CURRENT SOURCE & DESTINATION from the
View menu. You cannot change selected drives from this screen.

To change the drives you have set up,  select SET UP DRIVES from the File menu.

To change your backup options, select SET UP DRIVES from the File menu and click NEXT.

Please note that to change your backup options, you have to set up your drives again, and you
will have to run a fresh image backup before you will be able to do further file backups.

EzBackup does not allow you to maintain two types of file backups.  If, for example, you have
existing INCREMENTAL BACKUPS and switch to the DEFAULT BACKUP MODE, all previous
INCREMENTAL BACKUPS will be deleted.

Each time you set up a pair of drives, you must run a new IMAGE BACKUP.  Until the IMAGE
BACKUP is completed, you will not be able to backup files.

After you set up a pair of drives, EzBackup will ask if you want to run the IMAGE BACKUP.  If
you do not wish to do the IMAGE BACKUP right then, click CANCEL when the START THE
IMAGE BACKUP NOW? message appears.  
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Chapter 3:  Creating an Image Backup

An IMAGE BACKUP is an exact byte-by-byte copy of the SOURCE DRIVE, including all operating
system, program and data files.  The IMAGE BACKUP is an integral part of the EzBackup backup
process. It will allow you to restore or replicate your entire SOURCE DRIVE in the event of a
catastrophic drive or system failure.

To make an IMAGE BACKUP, you must have a BACKUP DRIVE which is at least as large as
your SOURCE DRIVE.  For example, if your SOURCE  (usually your internal C:\) DRIVE has a
total capacity of  80 GB , you will need a BACKUP DRIVE that is 80 GB or larger.  Your BACKUP
DRIVE may be a fixed or a removable hard drive.  EzBackup does not support making backups to
removable media (such as floppy disks, Zip disks, CD, DVD) or to network drives.

Initial Image Backup

Once you have selected your drives and the backup options you want, EzBackup will ask to start
the IMAGE BACKUP. Click OK. 

EzBackup will restart your computer and create an IMAGE BACKUP (an exact duplicate) of your
SOURCE DRIVE on the BACKUP (Destination) DRIVE.  All existing data on the BACKUP DRIVE
will be overwritten.

A data transfer progress screen will appear.  When the IMAGE BACKUP has been successfully
completed, a message will request that you PRESS ANY KEY TO CONTINUE....  Press any key
at this time and your computer will be rebooted back to Windows (unless you have manually
disabled the keyboard interaction option in EzBackup preferences in which case you need do
nothing; your computer will be restarted automatically.)  

The next time that EzBackup runs, it will ask you to accept the FACTORY DEFAULT schedule
settings. If you are satisfied with the default settings, click YES. Otherwise, click NO to change
the DEFAULT BACKUP SCHEDULE parameters.

Each time you set up a pair of drives, you must perform an IMAGE BACKUP or you will not be
able to perform any FILE BACKUPS.
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The FACTORY DEFAULT SCHEDULE is set to backup NEW AND MODIFIED FILES everyday at
4:00 P.M.

You have now completed setup of EzBackup. Your BACKUP DRIVE now contains an image copy
of your SOURCE DRIVE, and the DEFAULT BACKUP SCHEDULE will run periodically to update
the BACKUP DRIVE with any new or modified files.
 
For information on backing up and restoring files, see Chapter 4: Backing Up Files and Folders
and Chapter 6: Restoring Files and Folders.

Image Backup from the EzBackup Application

After you have set up EzBackup, you may want to run image backups periodically. To run an
IMAGE BACKUP, click on the Tools menu and select IMAGE BACKUP.  

Image Backup Using the Recovery CD

It is also possible to create an IMAGE BACKUP using the EzBackup Recovery CD. This requires
booting up your computer from the EzBackup Recovery CD. 

To do this, place the Recovery CD in your CD-ROM drive, reboot your computer and wait a few
moments for the PRESS ANY KEY TO BOOT FROM CD... message to appear. 

If you do not see this message (or if you see the usual Windows loading messages or your
Windows desktop), you have not successfully booted from the CD. See the Troubleshooting
section of this manual for help or refer to Appendix A for instructions on how to enable booting
from the CD-ROM drive. 

As the system boots from the Recovery CD, a “Loading... Please Wait...” message will appear on-
screen for several seconds while EzBackup Recovery Program starts up. 

When the EzBackup Recovery Program appears, click on the BACKUP tab.
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Verify that the source and destination drives are correct and click YES to continue.

The IMAGE BACKUP will begin.
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When the IMAGE BACKUP is done, wait for the Recovery CD to be ejected. Then remove it and
store it in a safe place. Click NEXT to restart the system.

How long does an image backup take?

Transferring an image over a Hi-Speed USB 2.0 connection will take approximately one minute
for each gigabyte of used space on the SOURCE DRIVE. 

To determine how much space is currently used on your SOURCE DRIVE, go to My Computer,
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right-click on Local Disk C:\ (assuming you selected the C:\ drive as your SOURCE DRIVE) and
select Properties.  Under the General Information tab, you will find information regarding the
size of your drive and the amount of free and used space on the drive.  

Backup times will vary based on the amount of data being transferred as well as the speed of the
backup device and connection type.  For example, transfers across a Hi-Speed USB 2.0
connection will be up to 40 times faster than those via a USB 1.1 connection.

Activating EzBackup

If you have not yet activated your copy of EzBackup software or are currently using a trial
version, a message will appear on screen each time EzBackup loads requesting you to
ACTIVATE, CONTINUE or EXIT the program.

You can activate your copy of EzBackup any time by selecting ACTIVATE EZBACKUP... from
the Help menu.

See Chapter 1: Installing EzBackup Software for information on how to activate your copy of
EzBackup.

Tip:  Run scheduled computer virus and spyware protection scans before making any backup to
help safeguard the integrity of your backup data.

It is recommended that you activate your EzBackup software as soon as possible.  The trial
version of the software allows you to restore files and folders, but only registered users have
access to the full image restore option.
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Chapter 4:  Backing Up Files and Folders

Once you have created your IMAGE BACKUP, you can begin backing up your files and folders. 
EzBackup provides you with a variety of options.

Backup Types

Click on the BACKUP tab to see your backup options. The choices are: All Files, New/Modified
Files, Selected Files and Default Schedule. 

Select the appropriate radio button and click NEXT to proceed with your chosen backup method.

All Files

EzBackup will back up all of the files on your SOURCE DRIVE. (Some files may be locked by the
operating system or by other running applications. EzBackup application will be unable to copy
these files during a file backup. To back up these restricted system and application files, you will
need to periodically re-image your drive.  To re-image your drive, select IMAGE BACKUP from
the Tools menu).

Once you tell it what to do, EzBackup works automatically in the background and will not interrupt
your work.  However, EzBackup can back up only those files that have been saved to your hard
drive.  Some applications, such as certain database programs, work primarily in memory, saving
their data only occasionally to the drive.  To ensure the highest level of data protection, close
active applications and make sure that all open files have been saved to your hard drive prior to
running the backup.
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New/Modified Files 

EzBackup will back up only files which have been added or modified since your last backup.
(Some files may be locked by the operating system or by other running applications. EzBackup
application will be unable to copy these files during a file backup. To back up these restricted
system and application files, you will need to periodically re-image your drive.  To re-image your
drive, select IMAGE BACKUP from the Tools menu).

 To ensure the highest level of data protection, close active applications and make sure that all
open data files are saved to your hard drive prior to your scheduled backup.

Selected Files 

EzBackup will backup only the files and folders you have selected.  

Choose the SELECTED FILES radio button and click NEXT to continue. The screen for selecting
files and creating backup job lists will appear. 
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The screen has three panels. The left panel displays the files on your SOURCE DRIVE as well as
the FILE TYPES that you can add to a backup job list. The middle panel show the file and folders
that have been added to the current job list. The box on the right contains the existing saved job
lists.
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Using Backup Job Lists

Create and use backup job lists to simplify backing up groups of files. Choose SELECTED FILES
from the BACKUP tab screen. Click on NEW in the Existing Lists window to create a new job list.  

To add to or delete items from an existing job list, select the name of that list from the Existing
Lists box.  The names of the files, folders and FILE TYPES within that job list will appear. 

From the source list on the left, select the files, folders and FILE TYPES that you wish to backup. 
Click ADD to include each item in your backup job list.  If necessary, click on the plus (+) signs in
front of the items in the SOURCE DRIVE panel to expand the drive or folders so that the
individual files are visible.  Added items will appear in the middle panel.  

Select the item name and click REMOVE to eliminate any unwanted items from your job list. 

Click the SAVE button at the top of the screen to save the current list.

Once you have selected all of the items you wish to include in your backup job list, click NEXT to
continue.  If you have not yet saved the current job list, EzBackup will ask if you want to save it
now. Select YES if you want to save the job list for future backups. Select NO if don’t want to
save it. Select CANCEL to cancel the backup.

If you say NO to saving the list of files you have just selected, EzBackup will then ask if you want
to backup the items you have selected anyway (without saving the list).  If you click YES,
EzBackup will start the backup of the items you selected. 
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If you save this job list as Fav. Pictures, for example, the name Fav. Pictures will appear in your

Existing Lists window.  You can now select this Fav. Pictures list by name whenever you wish to
create a backup schedule which includes this list of items.  Backup job lists in the Existing Lists
window can be viewed, modified, and re-saved as often as necessary to best suit your backup
needs.  Right-click on the job list name to quickly SAVE, CLEAR or DELETE a list. 
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File Types

In addition to files and folders, EzBackup also provides a FILE TYPES option in the source list
window.  The FILE TYPES icons allow you to easily select for backup all of the files in the My
Documents folder and/or all files of a certain file type, such as pictures and music files.  

Items listed under FILE TYPES cannot be expanded to display individual files and folders.  If you
wish to backup individual files or folders within the My Documents folder or within a FILE TYPE
(rather than the entire folder or every file of a particular type), simply expand the Local Disk
(SOURCE DRIVE), using the plus sign (+) to navigate to the desired files or folders and select the
individual items.  For example, to backup a particular file within My Documents, click on the plus
(+) sign next to Local Disk to show the list of files and folders.  Click on the plus sign next to
Documents and Settings and select a user.  Click on the plus sign next to that user name, then
the plus sign next to My (or a particular user’s name) Documents and select the required file.

EzBackup also provides backup of Microsoft Outlook Mail files. If Outlook is installed on your
computer, you can add the Outlook Mail file type to a job list, and EzBackup will temporarily shut
down Outlook when it is ready to back up those files so that it can copy your Outlook mailbox data
(which is locked while Outlook is running).
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Default Schedule 

EzBackup will run a backup immediately using the settings from the DEFAULT SCHEDULE. The
DEFAULT SCHEDULE can be modified to suit your needs.  (See Chapter 5: Scheduling File
Backups for instructions on modifying the DEFAULT SCHEDULE).
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Chapter 5:  Scheduling File Backups

You determine how and when EzBackup will execute your backups.  EzBackup provides a variety
of backup scheduling options and can store up to eight (8) unique backup schedules.  (Because
file backups work in conjunction with an image backup, no file backups can take place until the
image backup has been performed.)

Backup schedules can be modified, disabled, or permanently deleted according to your needs.

Once created, each backup schedule will be automatically executed at the time you have
selected for it.  For example, you may schedule a backup of all new and modified files for every
day at 6:00 P.M.  In addition, you may schedule a backup of selected files at 10:00 A.M., another
at 12:00 P.M., another at 2:00 P.M. and another at 4:00 P.M.  Your backup list will now include
five separate backup schedules, all of which will execute automatically.

Scheduled backups will only run if EzBackup is running. EzBackup is set up to launch
automatically when Windows starts and run in the background so that it can start your scheduled
backups when they are due to be run. If you disable EzBackup from running at startup, you must
remember to manually launch EzBackup if you want your scheduled backups to run at the
selected time. 

To know if EzBackup is running, look for the EzBackup icon in the system tray. This icon will
always appear even if EzBackup is running in background mode. If the EzBackup icon is visible in
the system tray, then EzBackup is running and your scheduled backups will run.
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Click on the SCHEDULE tab.  The Schedule Options screen offers three options:  CREATE NEW
SCHEDULE, VIEW OR MODIFY CURRENT SCHEDULE, and VIEW THE DEFAULT
SCHEDULE.  

Select an option and click NEXT to continue.  
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Setting Up a Scheduled Backup

Click on the SCHEDULE tab.  Select CREATE NEW SCHEDULE.  The Schedule Settings screen
will appear.  Each schedule you create will be automatically numbered.  EzBackup allows you to
create a total of eight (8) unique schedules.

Click the radio button for the type of backup you wish to create from the BACKUP TYPE list.
Choose how often you would like your backups to take place by selecting one of the choices from
the FREQUENCY list. 

If you select DAILY, WEEKLY, MONTHLY or ONE TIME ONLY, you will be required to select a 
time from the START AT box.  If you select WEEKLY, a list of days will appear and allow you to
select a particular day or days.  If you select MONTHLY, both the DATE and TIME drop down
lists will become active under the START AT heading. 

After selecting your schedule options, click NEXT to continue.  EzBackup will advise you that your
backup schedule has been changed and ask if you wish to save the changes.  If the details of the
new schedule are the way you want them, click YES to save the changes.  Your new schedule will
be assigned a number and will now be displayed in your SCHEDULE LIST. 
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Upon Event

EzBackup offers the unique ability to schedule a backup to happen UPON EVENT.  This feature
allows you to select an event which, when it occurs, triggers an automatic backup.  If your
BACKUP DRIVE is not always connected or you are not able to guarantee that the computer or
BACKUP DRIVE will be powered on at a specific time, you may wish to have EzBackup run your
backups when one of the following events occur.

USB Connection

EzBackup will launch a backup whenever your computer senses that your external USB BACKUP
DRIVE has been connected (or powered on).

Button Pressed

Some external drives feature an auto-launch backup button (not the on/off switch.)  EzBackup
can be set to launch whenever that auto-launch button is pressed.

System Shutdown

EzBackup can be set to run a backup whenever Windows receives a Shut Down command. (This 
will not be triggered by simply restarting Windows.)

Select the appropriate EVENT for your needs and click NEXT to save the schedule.
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Viewing an Existing Schedule

You can view the details of your scheduled backups, make changes, or delete a schedule
completely.  Click on the SCHEDULE tab, select VIEW or MODIFY CURRENT SCHEDULE and
click NEXT.  The SCHEDULE LIST screen will appear and display all of your current schedules.  

The Schedule List 

Each line in the SCHEDULE LIST represents an existing schedule and indicates the type of
schedule, how often the schedule executes, what days (if applicable) it is set to run, when it
executed last, when it will execute next, and the current status of the schedule.  Each schedule
will displayed in the SCHEDULE LIST automatically execute at its designated time (unless it is
disabled).

Double-click on a line to modify that schedule.  Right-click on a line to temporarily DISABLE or
re-ENABLE or permanently DELETE that schedule.
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Modifying the Default Schedule

EzBackup includes a FACTORY DEFAULT backup schedule that is set to backup New and
Modified files every day at 4:00 P.M.  If this schedule is appropriate for your needs, you need do
nothing.  EzBackup will simply run the backup every day at 4:00 P.M. and back up your new and
modified files. If, however, you wish to change or eliminate this 4:00 P.M. backup schedule, you
can change or delete it at any time.

To modify the DEFAULT BACKUP SCHEDULE, click on the SCHEDULE tab, select  VIEW THE
DEFAULT SCHEDULE, and click NEXT.  Select the BACKUP TYPE, FREQUENCY and/or
EVENT and the START AT time, if required, and click NEXT to save the changes.  
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Chapter 6:  Restoring Files and Folders

EzBackup makes it easy to restore files and folders from your BACKUP DRIVE.  The procedure
for restoring files and folders will depend on whether you selected the DEFAULT BACKUP MODE
or the INCREMENTAL BACKUP MODE when you set up your drives.  (Go to HARDWARE
PROPERTIES under the View menu to see your current Backup Mode. See Selecting Backup
Options in Chapter 2: Setting Up EzBackup for instructions on setting or changing the backup
mode.)

When Using Default Backup Mode

To restore files from your BACKUP DRIVE, click on the RESTORE tab. The restore screen will
appear.  The list on the left of the screen reflects the contents of your BACKUP DRIVE.  Select
the files, folders and/or FILE TYPES you wish to restore from this list.  You may need to click the
plus sign (+) to expand the drive and/or folders in order to navigate to the required items.  

Click ADD to include these files, folders and/or FILE TYPES in your list of items to be restored.
Selected items will appear in the box to the right. Click REMOVE to remove any unwanted items
from the your list. 

Click NEXT to continue.  Click OK when prompted to restore the selected files.  

In the above illustration, the BACKUP DRIVE appears as EzBackup Drive (F:\).  Your drive letter
may differ, depending on the settings of your particular computer. 
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When Using Incremental Backup Mode

Unlike the DEFAULT BACKUP MODE which overwrites the previous backup of files saved on the
BACKUP DRIVE with the latest backup of those files, the INCREMENTAL BACKUP MODE allows
you to retain several backups of a file in a separate restore point. 

The incremental backups use the most recent IMAGE BACKUP as their baseline.  Then, based
on your backup preferences (such as All Files, New/Modified Files or Selected Files), only the
particular files and/or folders you have requested to be backed up are saved to the BACKUP
DRIVE during your scheduled file backups. 

Each INCREMENTAL BACKUP carries a record of the date and time (restore point) in which it
was created.  This allows you to select a particular point in time from which to restore your files.  

Incremental Backup Restore Options

To restore files and folders  from your BACKUP DRIVE, click on the RESTORE tab.  The Select
Restore Type screen will appear and present a list of restore options.  Select the appropriate
restore type and click NEXT to continue.
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Selected Files From a Specific Date

Select SELECTED FILES FROM SPECIFIC DATE and click NEXT if you wish EzBackup to
restore to your SOURCE (usually the C:\) DRIVE only some of the files backed up on a particular
date.

The restore screen will appear.  The contents of your BACKUP DRIVE will appear on the left of
the screen.  The contents of your BACKUP DRIVE will be the backups you have made of your
SOURCE DRIVE (usually the C:\ drive) and will be listed as BACKUP FILES FROM C:\. 

Select the files, folders and/or FILE TYPES you wish to restore from this list.  You may need to
click the plus sign (+) to expand the drive and/or folders in order to navigate to the required items. 

Click ADD to include these files, folders and/or FILE TYPES in your list of items to be restored.
Selected items will appear in the box to the right. Click REMOVE to remove any unwanted items
from the your list. 

SELECTED FILES FROM SPECIFIC DATE is only for the purpose of restoring specific user files
(such as files saved in your My Documents folder or on your Desktop) back to the SOURCE
DRIVE. 

If you want to restore your operating system and/or any of your applications, or if you wish to
restore your BACKUP to a replacement drive, boot from the Recovery CD and do an IMAGE
RESTORE. (See Chapter 7:  Restoring an Image Backup on page 34.)  

Do not use SELECTED FILES FROM SPECIFIC DATE to restore system files; system instability
could result.
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Specific File From a Previous Backup

Select SPECIFIC FILE FROM PREVIOUS BACKUP and click NEXT if you want EzBackup to
show you the backups of a particular file that are saved on the BACKUP DRIVE.

Select the file you want to search for and click NEXT. EzBackup will display a list of backups of
that file that are available to restore. 

Select the backup date you want to restore and click NEXT to continue. EzBackup will restore that
backup of the file to its original location on your SOURCE DRIVE. 
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Overwriting Existing Files

 

Restoring All Files

To restore all the files copied in a backup, you must boot from the Recovery CD and perform an
IMAGE RESTORE. This is because the backup files may include some system files that cannot
be replaced while Windows is running. See the next chapter Chapter 7: Restoring an Image
Backup for more information.

You may also see the following warning when you try to restore files from your backups. It is a
reminder that you should boot from the Recovery CD if the files you want to restore include
system files that cannot be replaced while Windows is running. For example, if you want to
restore installed programs or if the items you want to restore include Windows system directories,
you must boot from the Recovery CD and use the EzBackup Recovery Program to restore the
backup.

If a copy of the file or folder to be restored already exists on your SOURCE (usually the C:\)
DRIVE, EzBackup will ask if you wish to replace that file or folder.  Click YES to replace the
existing item, YES TO ALL to replace all existing items, NO to skip the current item, or NO TO
ALL to skip all items (cancels the restore).
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Chapter 7:  Restoring an Image Backup

If you have a more serious problem with your system due to corruption of system files—or even
physical damage to the SOURCE DRIVE, the ability to restore individual files or folders may not
offer an adequate solution.  In such instances, you may need to perform an IMAGE RESTORE
which will copy your IMAGE BACKUP as well as all of your file backups back to your SOURCE
DRIVE or to a replacement drive. 

The  IMAGE RESTORE is a byte-by-byte restoration of the BACKUP DRIVE, including all system,
formatting, and program data.  An IMAGE RESTORE overwrites all the data on the original
SOURCE DRIVE with the backup data from the BACKUP DRIVE.

If your SOURCE DRIVE is the system drive that Windows runs from (normally the C:\ drive), you
should only restore the IMAGE BACKUP back to the original source drive or to a replacement
drive connected to the same computer. Restoring the IMAGE BACKUP to the system drive of
another computer may result in system instability. 

This is because an IMAGE BACKUP created from a system drive includes system information
specific to the computer that it was created on, such as information about the hardware that was
connected to the system (the type of processor, special drive setups, the video display card,
etc). Using this system information to run a different computer could cause Windows to become
confused and lead to system crashes.

IMAGE RESTORE capability is not available in the trial version of the
software.  An activated copy of EzBackup and an EzBackup Recovery
CD are required to perform an IMAGE RESTORE.

The IMAGE RESTORE process cannot be run from within Windows.  This is because it replaces
system files that are necessary for Windows to run properly. Thus, the IMAGE RESTORE must
be run from the EzBackup Recovery CD.  The Recovery CD runs Windows PE, which contains
its own operating system files that allow it to boot up the computer.  However, to utilize this
capability, your computer must be capable of booting from the CD-ROM drive.  Virtually all
computers are capable of booting from the CD-ROM drive. However, not all computers have this
capability enabled by default.  For instructions on how to enable booting from the CD-ROM
drive, see Appendix A at the end of this product manual.
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Creating a Recovery CD

If you do not have a copy of the EzBackup Recovery CD (such as if you installed EzBackup from
a web download), you will need to create a one in order to be able to do IMAGE RESTORE.

To create a Recovery CD, you will need a CD-R/W (CD writer) drive and a blank CD (a CD-R or
CD-RW disc).

Place a blank CD into the CD-R/W drive. From the Tools menu in EzBackup, select CREATE
RECOVERY CD.  EzBackup will check to see if it has the data it needs to create the Recovery
CD. If not, it will need to retrieve this data from the web.

Click OK to begin the download if asked.

When the download is complete, EzBackup will be ready to burn the Recovery CD to the blank
disc.
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If your CD writer is not selected in the drive window, click the down arrow to view additional
devices or click on REFRESH.  Make sure there is a writable CD in the drive and click NEXT. 
The disc will be ejected when the burn process has completed.

Begin the Image Restore

To begin the IMAGE RESTORE process, insert the EzBackup Installation & Recovery CD (or a
Recovery CD that was created by the application) into your CD-ROM drive and restart the
computer.  If booting from the CD-ROM drive is enabled, a message will appear for a few
seconds that says “PRESS ANY KEY TO BOOT FROM CD... ” At this time, press any key on
your keyboard to boot from the Recovery CD.

If you do not see this message (or if you see the usual Windows loading messages or your normal
Windows desktop), you have not successfully booted from the CD. See the Troubleshooting
section of this manual for help or refer to Appendix A for instructions on how to enable booting
from the CD-ROM drive. 

As the system boots from the Recovery CD, a “Loading... Please Wait...” message will appear on-
screen for several seconds while the EzBackup Recovery Program starts up. 
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When the EzBackup Recovery Program appears, click on the RESTORE tab. 

Confirm that the source is the BACKUP DRIVE that you want to restore from.  Confirm that the
destination selected is the drive that you want to restore to (or change the selection to the correct
drive).  Click YES to proceed with an IMAGE RESTORE to the selected destination drive.  
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EzBackup will ask a second time if you want to continue with the IMAGE RESTORE.  Click YES.

The IMAGE RESTORE will begin.

The IMAGE RESTORE will overwrite everything on the destination drive with data from your
BACKUP DRIVE (the restore source).  

If you set up EzBackup to use DEFAULT BACKUP MODE, doing an IMAGE RESTORE will also
restore your latest file backups. See the section below titled Completing the Image Restore
Process for the final steps.

If you set up EzBackup to use INCREMENTAL BACKUP MODE, see the next section Restoring
Incremental Backups for how to restore your INCREMENTAL BACKUPS. 

Restoring Incremental Backups

If you set up EzBackup to use DEFAULT BACKUP MODE for your regular backups, when you
perform an IMAGE RESTORE, your restore will include all the latest files from your regular
backups.

If you set up EzBackup to use INCREMENTAL BACKUP MODE, after you have performed an
IMAGE RESTORE, the EzBackup Recovery Program will now give you the chance to restore
your FILE BACKUPS.
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After completing the instructions above for performing an IMAGE RESTORE, wait while the
EzBackup Recovery Program remounts the newly restored drive.

You can always return to the EzBackup Recovery Program at a later point in time to restore more
INCREMENTAL BACKUPS to the drive. (You can only restore INCREMENTAL BACKUPS to a
drive that you have previously done an IMAGE RESTORE to).

Simply make sure that the backup drive and the drive that you want to restore to are connected to
the computer and turned on. Insert the EzBackup Recovery CD into the CD-ROM drive and
restart your computer.  When the EzBackup Recovery Program appears, select the RESTORE
tab.  
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You can select from 3 options for restoring your INCREMENTAL BACKUPS:

Latest

Select LATEST if you want EzBackup to restore the LATEST files from your regular file backups.
This is the most commonly used option. The EzBackup Restore Program will update the newly
restored drive with the most recently backed up version of each file.

Specific Date

Select SPECIFIC DATE  if you want EzBackup to restore only the files included in a particular
backup. Since EzBackup maintains each backup as a dated restore point, you can select only the
particular backup that you want to restore by selecting that date (restore point) from the drop-
down list. The EzBackup Restore Program will copy to the newly restored drive just those files
that were backed up in that restore point.
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Latest from Specific Date

Select LATEST FROM SPECIFIC DATE if you only want to restore backups up to a particular
restore point. This could be the case if you know that there are problems (corruption,
virus/spyware infection) on your computer that could have been copied into later backups and so
you would not want to restore them. The EzBackup Restore Program will restore the most
recently backed up version of each file that was backed up before and including the restore point
that you selected.
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Once you have selected the option you want, click NEXT to start restoring your INCREMENTAL
BACKUPS.

When EzBackup has finished restoring the INCREMENTAL BACKUPS, you are ready to
complete the IMAGE RESTORE process with the following final steps.

Completing the Image Restore Process

When the EzBackup Recovery Program is finished, it will display a list of the final steps that need
to be done to complete the IMAGE RESTORE process. Make sure to follow these steps carefully,
to avoid problems booting from your newly restored drive.
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First, the CD-ROM drive will eject the Recovery CD.  Remove the EzBackup Recovery CD from
the CD-ROM drive. Click NEXT to shut down your computer.

If you are restoring a system drive (the drive that Windows boots from, normally the C:\ drive):
Before rebooting the computer, disconnect the BACKUP DRIVE from the system. You need
to boot from the newly restored drive at least once to give Windows the opportunity to recognize
or re-recognize the drive as its primary boot drive. If you fail to do this, Windows may boot
from the BACKUP DRIVE instead of the restored drive.

When Windows reloads, open My Computer and verify that your SOURCE (usually C:\) DRIVE
was successfully restored. 

If your BACKUP DRIVE is an internal drive, you can do this by disconnecting the drive’s power
and data connectors. If your BACKUP DRIVE is an external drive, simply flip the off switch
and/or disconnect the drive’s power cable and its (USB or FireWire) PC connection. 
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(If EzBackup displays a message saying that it can’t find the BACKUP DRIVE you set up and
asking if you want to choose another drive, click NO to ignore it for now.)

You can now re-connect your BACKUP DRIVE.

Your system is now fully restored and ready to resume normal backup operation with EzBackup.

If your backup drive is an internal drive, shut down the computer, reconnect the drive’s power
and data connectors, and start up again. If your backup drive is an external drive, you do not
need to shut down the computer. Just reconnect the drive’s power cable, turn it on (if it has a
power switch) and reconnect it to the computer. 
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Chapter 8:  Migrating to a Replacement Drive

It is sometimes necessary to replace your computer’s hard drive. This could be because of a
mechanical failure in the old drive, or because you want a drive with a larger capacity. When you
replace a hard drive, you will need to copy all the data from the old drive to the new drive. This
process of moving data to a new replacement drive is called migration, and EzBackup makes it
easy.

As long as all the data on your SOURCE DRIVE has been backed up to your BACKUP DRIVE, all
you have to do is install the new drive in your computer and perform an IMAGE RESTORE to it.
EzBackup will transfer to the new drive all the data it has backed up from your old SOURCE
DRIVE, and you will be able to immediately start using your new drive, without having to reinstall
the OS, your applications, and all your files and settings.

Before migrating to a new drive, make sure that you have a current IMAGE BACKUP of your
SOURCE DRIVE on your BACKUP DRIVE. 

See Chapter 7: Restoring an Image Backup on page 34 for instructions on using IMAGE
RESTORE to transfer your information to a new drive.

Using the Partition Expander

The PARTITION EXPANDER will help you complete the process of migrating (moving your data)
to a larger drive. It is a utility that can expand hard drive partitions, and it will allow you to reclaim
the remaining storage space that seems to be missing after you use IMAGE RESTORE to
migrate to a larger replacement drive.

To use EzBackup, the BACKUP DRIVE has to be at least as large (or preferably larger) in
capacity than the SOURCE DRIVE you want to back up.  If you replace your existing SOURCE
DRIVE with a new drive which is larger than your existing BACKUP DRIVE, you will need to
replace the BACKUP DRIVE with a drive that is at least as large as the replacement drive. 

When using IMAGE RESTORE to migrate to a new drive from your IMAGE BACKUP, it is
necessary to understand that the usable storage space on the new SOURCE DRIVE will initially
be limited to the size of the old SOURCE DRIVE.  Say, for example, that your old SOURCE
DRIVE had a total capacity of 40 GB and that your new drive has a total capacity of 120 GB.
The IMAGE RESTORE process will copy a 40 GB partition to your new drive that is the image of
the data from your old drive.  This 40 GB partition will appear in My Computer as if it were the
entire drive and you will not have access to the remaining 80GB of capacity on the new drive.  

The PARTITION EXPANDER provides a quick and easy method to reclaim this missing extra
capacity. 
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After completing all the steps to restore the IMAGE BACKUP (and the latest of any
INCREMENTAL BACKUPS, if present) to the new drive, you are ready to expand the partition on
the new drive.

Boot from the Recovery CD (just as you did to perform the IMAGE RESTORE). When the
EzBackup Recovery Program appears, select DISK MANAGER from the Tools menu.

Click on the drive icon that represents the new replacement drive (or another drive that you want
to expand). Note that the drive letter assigned to the drive may be different than usual. Move the
mouse pointer over each drive to display that drive’s properties so that you can select the right
one.

When you click on a drive, EzBackup displays the drive layout.
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The green area shows the amount of drive capacity that has been allocated to a partition. The
yellow area labeled “Unallocated” shows you how much remaining space there is to reclaim on
the drive.

Right-click in the green area that indicated the partition that you want to expand and select
EXPAND PARTITION from the drop-down menu. 
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A slider indicates how much the partition can be expanded.

Drag the slider to expand the partition size. 

When you have set the slider to indicate your desired partition size, click NEXT to start the
expansion.
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Using the Partition Expander in Windows

You can also use the PARTITION EXPANDER included in the EzBackup Application from
Windows. However you will not be able to expand your new replacement drive if it is the system
drive that Windows runs from (normally the C:\ drive).

Select PARTITION EXPANDER from the Tools menu.  The PARTITION EXPANDER screen will
appear.  Your SOURCE and BACKUP DRIVES will appear in the HARD DRIVE drop-down box. 
If you have additional hard drives attached to this computer, these hard drives will also appear in
the drop-down box.

Select your replacement drive from the HARD DRIVE drop-down list.
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The CURRENT HARD DRIVE STATISTICS box will show you with the current layout of the
partitions on your new SOURCE DRIVE.  The total size of the partitions will add up to the entire
size of your old SOURCE DRIVE.  The remaining free space will reflect any extra space on the
new SOURCE DRIVE.  

The EXPANDED box will show you what the layout of the drive will look like after the expansion.

Select the existing partition, use the up-down arrows to adjust the TARGET PARTITION SIZE to
the desired size, and click START.  When the expansion is finished, the CURRENT HARD
DRIVE STATISTICS will be updated with the new partition size.

Click EXIT when you are done.
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 Chapter 9:  E-mail Notification

EzBackup operates in background and will initiate a scheduled backup even when no one is
present.  If you feel the need for confirmation that backups have actually taken place while you
have been absent, you may activate E-MAIL NOTIFICATION.  This option has been provided to
allow you to be notified by e-mail that scheduled backups have, in fact, taken place and have
been successful.  

Select E-MAIL NOTIFICATION from the Tools menu. The E-mail Notification screen will appear.  

Enter the e-mail address you want notifications to be sent to, the address to be used as the
sender, the mail service (SMTP) address (for example, mail.myprovider.com) and a readily
recognizable subject line (such as: Backup Report Bob’s Computer) to appear in the message. 

Use SEND A TEST MESSAGE to ensure that the information has been properly entered and the
notification feature is working properly.  Check your e-mail inbox to verify that the notification has
arrived.

The default notification option is DO NOT NOTIFY.  To enable E-MAIL NOTIFICATION, select
one of the other notification options: NOTIFY AFTER EVERY BACKUP, NOTIFY IF A BACKUP
FAILS or NOTIFY IF A BACKUP IS SKIPPED.
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Chapter 10:  Preferences

Select PREFERENCES from the Edit menu to modify the preferences. 

Logging

EzBackup automatically tracks activity whenever EzBackup is running. There are three options
for running your log files.  You may disable all logging activity, maintain a log of only those files
that were scheduled to copy but did not copy or maintain a log of all the files actually copied in
each backup.

To view a copy of your current log file, select VIEW LOG from the View menu.  

To clear the log file of all information, select CLEAR LOG from the View menu.

EzImage

Some computers, laptops in particular, may not be able to respond to the prompt to “Press Any
Key to Continue...” which appears at the end of the IMAGE BACKUP process.  If this issue arises,
select DISABLE KEYBOARD INTERACTION from the preferences screen to tell EzBackup to
continue without waiting for keyboard input.

Startup

EzBackup is set by default to load when Windows starts up.  If you prefer to launch EzBackup
manually, deselect the LOAD EZBACKUP AT STARTUP option. 
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Chapter 11:  Tips and Guidelines

Do… perform regular system maintenance to keep your computer in good condition, such as
running antivirus scans and updating security patches for your OS and applications.

Do… keep your antivirus and anti-spy ware software up-to-date.

Do… maintain your hard drive data by backing up regularly. Take advantage of the benefits of the
Scheduled Backup feature.

Do... perform regular image backups of your hard drive to insure that all files are properly backed
up. Some files are locked by the operating system or by an active application, and so cannot be
copied during a regular file backup.

Do… perform an image backup after you make any major changes to the system, such as
installing a new application or new hardware.

Do not… use EzBackup to copy applications from one computer to another.

Do not… perform an image restore to the system drive on a different computer than the one you
created an image backup from. System instability could result because the image backup
contains system information specific to the original computer’s hardware.
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Chapter 12:  Troubleshooting

We have tried to make the use of EzBackup as uncomplicated and self-explanatory as possible. 
However, if you are experiencing difficulty installing or using EzBackup, this chapter may provide
useful suggestions for dealing with these issues. 

If you find that the solutions and guidelines presented here do not satisfy your specific needs,
please refer to the How to Get Help section at the end of this chapter.

Installation

Q:  I inserted the EzBackup Installation CD but the installation splash screen does not
appear automatically.

A: Go to My Computer and double-click on your CD-ROM drive (often D:\ or E:\). If the
installation screen still does not appear, right-click on the drive icon and select Explore.  Double-
click on the Windows folder to open it and then on the EzBackup folder. Double-click on the
setup.exe file to launch the installation.

Q:  I see two EzBackup drive icons in My Computer.  Is this normal?

A:  If you have selected the INCREMENTAL BACKUP MODE option, two EzBackup drive icons
may appear in My Computer after you do an IMAGE BACKUP.  This is normal. The first drive is
your BACKUP DRIVE and contains the image backup; the second drive is also part of your
BACKUP DRIVE which will contain the INCREMENTAL BACKUPS.
  

Drive Information

Q: How can I quickly see the type and size of my SOURCE and BACKUP DRIVES?

A: From the View menu, select HARDWARE PROPERTIES. Click on BACK to exit this screen.

Recovery CD

Q: I inserted the EzBackup Recovery CD and restarted my computer but the EzBackup
screen did not appear.  Instead the Windows logo or the usual Windows loading messages
appeared on screen.

A: It seems likely that your computer is not set to boot from the CD-ROM drive.  You will need to
change the boot sequence (the order in which the computer system looks for drives to boot from.) 
This is not a difficult process, however, it requires accessing and adjusting the BIOS settings on
your computer.

If you know  the key sequence (keys to press) to open the boot menu for your machine or that will
make it boot from a CD, you should restart your system and enter those keys as the computer
starts up.  If you do not know how to do this, see Appendix A of this manual for instructions on
how to access your computer’s BIOS settings.
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Also, your computer manual or manufacturer’s website may provide instructions on how to boot
your computer from a CD.

Once you have entered the Setup menu of your computer’s BIOS, look for a menu option called
BOOT or BOOT SEQUENCE and put the CD drive ahead of the hard drive in the boot order list.
Then exit the BIOS settings mode, saving your changes, and allow the computer to restart.

Q: I booted from the EzBackup Recovery CD and then accidently removed the CD from the
CD-ROM drive before/while running the IMAGE BACKUP/RESTORE.  I have tried replacing
the CD but my computer won’t respond.  What should I do?

A: Once, you boot from the Recovery CD, it should not be removed until the image process is
completed.  If the system will not respond, make sure the Recovery CD is seated properly in the
CD-ROM drive, disconnect the computer from power, wait at least 30 seconds, then reconnect the
power and restart the computer.  Your system should boot from the Recovery CD and load the
EzBackup Recovery Program. Because it is running from the CD, the application may take a few
moments to load. 
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How to Get Help

If you should find that you need help beyond what is offered in this manual, please contact
Technical Support. (Support is available Monday through Friday from 9:00 AM to 5:00 PM ET).

By telephone 954.925.7347

By fax 954.925.2889

By e-mail technicalsupport@EzD2D.com
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Appendix A

Accessing the Computer BIOS Settings

Many computers display BIOS access instructions while the computer boots. Pressing a particular
key or combination of keys before the operating system begins to load will allow you to access the
BIOS. 

In many cases you need only press the DELETE key after the first visible text appears on your
screen to interrupt the loading process and enter the BIOS screen. Other commonly used keys
are ESC, F1, F2, F10, CTRL-DELETE. For more information, check the documentation that came
with your computer or refer to the list below.  

When you reach the BIOS screen, look for the BOOT SEQUENCE option. If it is not listed on the
initial BIOS screen, check the other screens of the BIOS setup.  The BOOT SEQUENCE option is
often found on an advanced setup page.  

If you continue to experience difficulty, please contact Technical Support at (954) 925-7347.
(Support is available Monday through Friday from 9:00 AM to 5:00 PM Eastern Time).
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